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APPENDIX

D

Like most programs, Photoshop groups all its commands into menus. On both 
Macs and PCs, Photoshop’s menus appear at the top of your screen in the menu 
bar. Strap yourself in and hold on tight for a warp-speed tour of Photoshop’s 

nearly 300 menu items!

 NOTE  All the page numbers mentioned in this appendix refer to the printed book, not pages in this appendix.

Photoshop
This menu, which appears only in the Mac version of Photoshop, includes items like 
information about the program, preferences, and the Quit command.

 NOTE  On a PC, you can find the items in this menu in the File, Edit, and Help menus instead.

ABOUT PHOTOSHOP
Select this item to see which version of Photoshop you’re running and to learn the 
names of the folks who wrote the program.

ABOUT PLUG-IN
This option shows info about all the different plug-ins installed in Photoshop—both 
the ones that shipped with the program and any custom goodies you’ve added.

  Photoshop Menu 
by Menu
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FILE
PREFERENCES

You can check out Photoshop’s preference settings by choosing this option. On a 
PC, go to Edit→Preferences instead.

SYNC SETTINGS
You can use this menu item to upload your settings to the Adobe Creative Cloud 
(things like tool presets, actions, workspaces, and so on), as well as download previ-
ously upload settings. (For more on the Creative Cloud, see the box on page xxvii; 
page 23 has the full scoop on syncing your settings.)

SERVICES
OS X includes a feature called Services that lets you do things like look up a word in 
the dictionary, send a chunk of text as an email message, summarize a passage of 
text, and so on. Any Service installed on your Mac shows up here. Photoshop, alas, 
doesn’t support OS X Services, so you can’t take advantage of ’em when you’re 
editing images.

HIDE PHOTOSHOP
In lieu of quitting the program, you can use this command to hide all of Photoshop’s 
menus, panels, and windows so you can work in other programs with less visual 
distraction (it’s like minimizing the Photoshop window on a PC.) To show Photoshop 
again, click its icon in the Dock or press c-Tab to see a list of currently running 
applications, and then tap the Tab key until you see a thin white square surround 
Photoshop’s blue, Periodic Table-style icon (it looks like a blue square with a capital 
P and lowercase s). To learn more about quitting the program versus hiding it, see 
the box on page 8.

HIDE OTHERS
Hides every program your computer is running except Photoshop.

SHOW ALL
Reveals every program you may have hidden using the Hide command.

QUIT PHOTOSHOP
Closes your open images and exits Photoshop. On a PC, you can quit Photoshop 
by choosing File→Exit.

File
The File menu is home to commands that let you open, close, and save documents; 
import and export files; browse files in Adobe Bridge; place files as smart objects; 
print documents; and so on.

NEW
Creates a new, empty document (page 38).
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FILE
OPEN

Lets you pick an existing document or image to open (page 47).

BROWSE IN BRIDGE
Launches Adobe Bridge in a separate window so you can import, organize, or locate 
images you want to work with. Chapter 22 covers using Bridge in detail starting on 
page 909.

OPEN AS SMART OBJECT
Lets you open a file as a linked smart object in a new Photoshop document (page 
51). For a full explanation of smart objects, see page 129.

OPEN RECENT
Displays a list of documents you’ve opened recently so you can reopen them without 
spending time rooting through your hard drive.

CLOSE
Closes the current document without saving it. If you’ve made changes to the docu-
ment, Photoshop displays a message asking if you want to save the changes; click 
Don’t Save, Cancel, or Save to continue.

CLOSE ALL
Closes every document you have open in Photoshop without saving them, though 
if you’ve made changes to any one of those documents, you get the same “Save 
changes…?” confirmation dialog box described above.

CLOSE AND GO TO BRIDGE
Closes the current document and opens Bridge (Chapter 22) so you can browse 
for other images.

SAVE
Saves the current document to your hard drive (page 44). If you’ve already saved 
the document, choosing this command overwrites the previous version (you’ve been 
warned!). If you haven’t saved the document before, choosing this command opens 
the Save As dialog box, explained next.

SAVE AS
Opens the Save As dialog box where you can save a copy of the current file with a 
new name or in a different format (page 45).

CHECK IN
If you use a digital asset management program to organize, track, and store files 
centrally so others can work on those files, too—such as Adobe Experience Manager 
(www.lesa.in/adobeem)—this menu item lets you check a file in after you’ve made 
changes to it. (You can think of digital asset management thing as having a personal 
librarian of sorts). However, you’ll first need to download and install Adobe Drive 
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(www.lesa.in/adobedrive) to tell Photoshop, and any other Creative Cloud programs 
you use, that you’re using a digital asset manager.

SAVE FOR WEB
This command opens a honkin’ big dialog box that contains up to four previews of 
your document with myriad options that let you save a copy of it in formats that 
work well with web browsers (page 771). You can also use it to resize documents 
(page 263).

GENERATE
Choose this command to turn on Generator, a feature that lets you export web 
graphics using very specific layer-naming conventions. Learn all about this amazing 
time-saving feature beginning on page 794.

REVERT
Wipes out any changes you’ve made to the current document and returns it to its 
last saved state

PLACE EMBEDDED
Use this option to place an image, or another Photoshop document, into your current 
document as an embedded smart object (page 134). The artwork lives in your docu-
ment, on its very own layer, surrounded by a bounding box you can use to resize it.

PLACE LINKED
This option also creates a smart object in your current document, though the content 
is linked to wherever it lives on your hard drive. This option is handy when you’re 
placing huge raw files or a whole Photoshop document into another document. See 
page 137 for more on managing linked smart objects.

PACKAGE
If you’ve placed linked smart objects into a document, you may find it difficult to 
round up all the linked content in order to hand the document off to someone else. 
This command locates all the linked content and copies it—and your Photoshop 
document—to a new location that you specify. Page 138 has more info.

IMPORT
When you choose this menu item, you see a submenu containing the following op-
tions for importing a variety of info into Photoshop:

• Variable Data Sets let you import files that are filled with info Photoshop needs 
to make customized images based on a template file.

• Video Frames to Layers lets you open a movie file’s frames as individual layers 
in a new document.

• Images from Device lets you use a scanner to get a picture, drawing, or any-
thing else off paper and into Photoshop on a Mac (see page 53 for more info).
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• Notes lets you import annotations into your image from PDF documents.

• WIA Support is available on PCs running Windows and lets you import images 
from an attached digital camera, memory card, or scanner.

EXPORT
Choose this menu item to export your image as paths (page 570) so you can open 
them with Adobe Illustrator, export collected data, export a sequence of images to 
video (see Chapter 20), or use the Zoomify plug-in to prevent people from down-
loading large images from web pages (see the box on page 804).

SHARE ON BEHANCE
When you’re ready to share the currently open document with the collaborative, 
portfolio-sharing Behance community, give this menu item a spin. To learn more 
about Behance, see the box on page 805.

AUTOMATE
As you learned in Chapter 18, you can automate tasks you do over and over in 
Photoshop by saving them as actions. This menu item lists the built-in actions that 
come with Photoshop.

SCRIPTS
Scripts go hand in hand with automation because they also handle repetitive or 
complex tasks for you. Photoshop’s built-in scripts (like the super handy Image 
Processor—see page 268) are listed here.

FILE INFO
Choose this item to see info (a.k.a. metadata) about the current document, including 
when it was created, how big the image is, its name, copyright information, and so 
on. You can also add and edit these details as described on page 799.

PRINT
Choosing this item opens the Photoshop Print Settings dialog box and lets you 
choose things like the number of copies, print quality, and which printer to use (see 
Chapter 16). After you get the settings just right, click Print to send your document 
to the printer.

PRINT ONE COPY
Pick this option to make Photoshop send the current document to the printer you 
normally use without giving you a chance to change any settings first. Think of Print 
One Copy as a quick-and-dirty way to print an image without encountering a slew 
of dialog boxes.

 NOTE  On PCs, the File menu also includes the Exit command.
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EDIt Edit
This menu is where you’ll find the Copy and Paste commands, Transform options, 
and keyboard and menu shortcut settings, among other items. If you use a PC, you’ll 
also find Photoshop’s preferences perched here.

UNDO
Make a mistake editing your image? Use this command to erase the last thing you 
did (see page 16).

STEP FORWARD
If you use the Undo command to backtrack through your image edits, you can move 
forward through them again by choosing this command (page 17).

STEP BACKWARD
Step Backward works just like Undo, but you can use it to go back more than one 
step (see page 16), which is incredibly handy.

FADE
This command lets you change the strength (opacity) and blend mode (page 296) 
of the last edit you performed. It works on filters, image adjustments, and so on. 
You can learn more about it in the box on page 493.

CUT
Copies the highlighted or selected item to your computer’s memory and deletes 
the original.

COPY
Copies the highlighted or selected item to your computer’s memory but leaves the 
original intact.

COPY MERGED
This command makes a merged copy of all the visible layers in a selected area. If 
you’re editing a multi-layered document, this is a handy way to quickly consolidate 
and copy a certain part of the image—the area you’ve selected—onto a single layer 
without having to select that area on each layer individually.

PASTE
Places objects you’ve copied to your computer’s memory into the current document.

PASTE SPECIAL
This menu item was renamed way back in Photoshop CS5 (it used to be called Paste 
Into) and gives you a few different options, including pasting one selection into 
another (by choosing Paste Into). For example, if you copy a selection (an image, 
say) and then create a selection in another document (such as a picture frame, as 
shown in the figure on page 286), you can use this command to make Photoshop 
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paste the contents of that first selection into the second one, complete with a layer 
mask. The other commands listed here are “Paste in Place” and Place Outside. Page 
286 has the scoop on these commands.

CLEAR
This command deletes whatever you’ve selected from the currently active layer.

CHECK SPELLING
If you add text to your image, this command checks it for spelling errors (see the 
box on page 636).

FIND AND REPLACE TEXT
This command lets you find specific words or phrases in your document and (if you 
like) replace them with different text (page 634).

FILL
This command fills the selected area with the color of your choice. If you don’t have 
an active selection in your document, the color fills the whole layer.

STROKE
This command adds a stroke (outline) the color of your foreground color chip to the 
currently selected area.

CONTENT-AWARE SCALE
This feature lets you change the size of an image without distorting the important 
parts, like people; see page 271.

PUPPET WARP
This command lets you twist and turn, move and distort pixels independently of 
other pixels in an image. By placing markers (called pins) on the object you want to 
move, Photoshop creates a mesh behind it that you can move the object along. It’s 
discussed in step-by-step glory on page 474.

PERSPECTIVE WARP
As page 479 describes, this command lets you correct the perspective in parts of 
your image using a grid that you draw atop the image.

FREE TRANSFORM
This command lets you scale, stretch, warp, distort, and rotate the selected object 
or a path (see page 276). Page 458 explains how to use this command to slim your 
subject.

TRANSFORM
Transform works like Free Transform but lets you change only one aspect of the 
selected object or path at a time. For example, you can rotate the object, but can’t 
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scale it at the same time (though you can choose another command from the same 
menu in order to perform multiple transformations). See page 276 for more info.

 NOTE  The Free Transform and Transform features work on individual layers or paths (as many as you’ve 
activated), not on your entire document.

AUTO-ALIGN LAYERS
This command makes it easy to merge several images into one perfect image (say, 
one where everyone is smiling) or to create panoramas from a group of similar im-
ages. When you run it, Photoshop looks for the common elements in each photo 
and aligns them automatically (see page 312).

AUTO-BLEND LAYERS
This option lets you combine the best parts of similar images into a single image; 
Photoshop creates all the necessary layer masks for you. Page 314 has the details.

DEFINE BRUSH PRESET
Choose this option to convert the selected object into a custom brush. Page 562 
has the scoop.

DEFINE PATTERN
This item makes a custom pattern out of your current selection (see page 94).

DEFINE CUSTOM SHAPE
This option turns the active path or vector mask into a custom shape (page 590).

PURGE
This item lets you clear Photoshop’s undo list, the items you’ve copied to your com-
puter’s memory (including its video cache), or the edits Photoshop has recorded as 
history states. You can also choose to clear all three at once.

ADOBE PDF PRESETS
This item lets you manage, edit, and add groups of settings you can use when mak-
ing PDF versions of images. Chapter 16 has more about using and working with 
documents in PDF format, beginning on page 727.

PRESETS
You can manage groups of custom brushes, patterns, shapes, colors, and styles by 
picking this menu item, which lets you edit or combine groups into new libraries, as 
well as delete groups. Page 32 gets you started working with presets.

REMOTE CONNECTIONS
This command lets you allow a wireless device or other program (say, digital asset 
management software) to connect with Photoshop.
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COLOR SETTINGS

This item brings up Photoshop’s advanced color settings so you can control color 
management and device profiles (see page 722).

ASSIGN PROFILE
This option is part of Photoshop’s color-management system. From here, you can 
assign specific color profiles to individual documents or disable color management 
(discussed in Chapter 16, starting on page 720).

CONVERT TO PROFILE
This option lets you change an image’s color-management profile (see Chapter 16).

KEYBOARD SHORTCUTS
Choose this item to customize Photoshop’s keyboard shortcuts, add your own, and 
save your personalized menu commands to share with other folks (see the box on 
page 31).

MENUS
Choose this option to see all of Photoshop’s menus and, if you like, tweak them (see 
the box on page 31).

 NOTE  In the Windows version of Photoshop CC, the Preferences option appears at the bottom of the Edit 
menu.

START DICTATION
Available only in the Mac version, this command lets you to speak commands or 
text directly into Photoshop.

Image
This menu groups together features for working with images and your canvas. You 
can resize documents, adjust Curves and Levels, duplicate images, and rotate im-
ages from here.

MODE
This is where you change the current document’s color mode (page 41) and bit depth 
(see the box on page 42). You can choose from Bitmap, Grayscale, Duotone, Indexed 
Color, RGB, CMYK, Lab, and Multichannel color modes and 8-, 16-, and 32-bit images.

ADJUSTMENTS
From here, you can change the colors and overall tonal quality of your image, though 
all the changes triggered from this menu apply to your currently active layer. That 
said, Chapter 9 has the full scoop on correcting images without harming your original!
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IMAGE
AUTO TONE

This command analyzes the current image and tries to adjust its overall colors to 
make it look better. Flip to page 378 to learn more about it.

AUTO CONTRAST
This command adjusts the contrast between light and dark areas in your images 
so that highlights look brighter and shadows look darker. Page 378 has more info.

AUTO COLOR
Artificial lighting can skew the colors in your image, though you can use this com-
mand to shift ’em back so they look more natural. Page 375 shows how you can use 
this command to zap a color cast.

IMAGE SIZE
This option lets you change your image’s resolution and dimensions. This dialog box 
is discussed at length beginning on page 255.

CANVAS SIZE
Choose this option to change your document’s dimensions without changing its 
file size or resolution. Use this command if you need more space in a document but 
don’t want to resize its content (see page 270).

IMAGE ROTATION
Use this item’s options to rotate your image and canvas. You can choose one of the 
presets—like 180° or 90° CW (clockwise)—or choose Arbitrary and then enter the 
number of degrees you want to turn the image.

CROP
This command lets you remove the edges of an image in order to produce a more 
visually pleasing composition or to change the image’s size. Photoshop keeps the 
area inside the crop box and removes the rest, leaving you with an image that’s 
physically smaller than it was before. See page 236 for more than you ever wanted 
to know about cropping.

TRIM
Like Crop, this command lets you trim away the edges of an image based on the 
color in each corner or on transparent pixels. This command is incredibly handy 
when you need to produce the smallest image possible for, say, use on the web or 
in a book (see page 246).

REVEAL ALL
This command shows you all your image’s hidden edges if you’ve cropped nonde-
structively (page 240) or pasted an object that’s larger than your current canvas 
size (see the Tip on page 92).
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DUPLICATE

Makes a copy of your current document and lets you give the duplicated document 
a new name.

APPLY IMAGE
This command lets you combine a layer and channel from one document with a 
layer and channel from another document using the blend mode and opacity of 
your choice (see page 227).

CALCULATIONS
This command works a lot like Apply Image, but instead of combining layers and 
channels, it combines only channels; see page 229 in Chapter 5 for more info.

VARIABLES
This menu item lets you designate areas of a document as placeholders for other 
images or text that Photoshop adds automatically from a specified data source (see 
the next item). It lets you create powerful document templates that you can use to 
generate several versions of the same basic design (with different images and/or 
text) automatically. See this book’s Missing CD page at www.missingmanuals.com/
cds for more about how this feature works.

APPLY DATA SET
Once you’ve created a document template containing variables, you can choose 
this menu item to tell Photoshop where the variable data—the other images and/ 
or text—lives so it can automatically create the various versions of the document.

TRAP
This command lets you set the spread of objects in your images, which controls 
how much colors overlap where they intersect. This setting is important in offset 
printing. Chapter 16 has more about preparing images for an offset press, starting 
on page 740.

ANALYSIS
Photoshop includes several tools for analyzing data in scientific images, counting 
objects, setting data points, and recording measurements. Most folks don’t need to 
use these features, but they’re really handy if you work in scientific research or foren-
sic analysis. (Two resources for learning more about these features are Photoshop 
CS3 Extended: Research Method and Workflows and Photoshop CS3 Extended for 
BioMedical Research, both of which are videos available for a fee from www.Lynda.
com. Even though they’re a bit vintage, they still offer great info about these tools.) 
Here’s what each of the options in this item’s submenu let you do:

• Set Measurement Scale. Use this option to tell Photoshop what scale to use 
when it counts. The default is one pixel equals one pixel, but you can change 
it to account for your image’s scale. If, say, one micron in your image fills the 
space of 50 pixels, you can set Photoshop’s scale to match.
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LAyER
• Select Data Points. Use this option to tell Photoshop what kind of info you want 

it to record when it counts. The program records all the data types you choose 
in the Measurement Log (described next).

• Record Measurements. Choose this command to see the Measurement Log 
panel, where Photoshop displays all the data it collects from your image.

• Ruler Tool. You can use this tool to measure items in an image (page 70). Click 
and drag across an object and its measurements appear in the Options bar 
and Info panel.

• Count Tool. This tool helps you tally up the number of items in an image. You 
can click objects to count them manually, or Photoshop can do its best to count 
them for you.

• Place Scale Marker. Use this tool to add a symbol to your image so people can 
tell what scale it’s in. Be sure to set your measurement scale, as noted above, 
if you’re using this tool.

Layer
This menu, not surprisingly, has controls for working with layers. From here you can 
do things like add and delete layers, create layer masks, and merge layers. Chapter 
3 has the complete lowdown on layers.

NEW
This command adds a layer or layer group to your image.

COPY CSS
As the Tip on page 637 explains, this command copies formatting and positioning 
info to your computer’s memory as cascading style sheet (CSS) code that you can 
paste into the nearest HTML editor.

DUPLICATE LAYER
This option does just what its name implies: Makes a copy of the currently active layer.

DELETE
Choose this item when you want to delete a layer. You can do the same thing by 
activating a layer and then pressing the Delete key (Backspace on a PC).

RENAME LAYER
This option highlights the name of the currently active layer in the Layers panel 
so you can rename it. (A little known fact is that you can also press the Tab key to 
highlight the name of the next layer down, or Shift-Tab to highlight the name of the 
next layer up.)
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LAYER STYLE

Go here to set the current layer’s blending options and apply effects such as drop 
shadows, glows, and gradient overlays. Page 139 in Chapter 3 has more about layer 
styles.

SMART FILTER
This option lets you delete or disable a smart filter mask. Chapter 15 has the scoop 
on using smart filters, starting on page 670.

NEW FILL LAYER
Go here to create a new layer and then tell Photoshop whether you’d like to fill it 
with a solid color, gradient, or pattern (see page 93). The neat thing about fill lay-
ers is that, when you change canvas size, Photoshop automatically fills in the extra 
space with the color, gradient, or pattern you picked. You can also change the fill 
color by simply double-clicking the fill layer’s icon in the Layers panel, which sum-
mons the Color Picker.

NEW ADJUSTMENT LAYER
This option creates a new adjustment layer so you can apply nondestructive changes 
to your images. Adjustment layers are defined on page 75, and they’re used exten-
sively throughout Part 2 of this book.

LAYER CONTENT OPTIONS
As of this writing, this menu item seems to be permanently dimmed so you can’t 
choose it. Way back in Photoshop CS5, you could use this option to change an 
adjustment layer’s settings. These days, just double-click the adjustment layer’s 
thumbnail in the Layers panel and the Properties panel opens, which contains those 
very same settings.

LAYER MASK
From here you can show, hide, delete, and apply layer masks, which are like digital 
masking tape (page 120).

VECTOR MASK
This option is like Layer Mask item above, but it lets you work with vector-based 
objects (page 606) instead.

CREATE CLIPPING MASK
This command lets you attach layers to one another so the content of one layer shows 
through the shape of what’s on the layer below. You can learn more about clipping 
masks in the box on page 133 and see one in action in the figure on page 666.

SMART OBJECTS
This menu item includes tools for working with smart objects—editing them, dupli-
cating them, and so on. See page 129 to learn all about smart objects.
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VIDEO LAYERS

This item lets you add, remove, and replace footage on video layers, as discussed in 
Chapter 20. You can also use this item’s options to restore video frames, add blank 
frames, and rasterize footage.

RASTERIZE
This command converts text, vector-based objects, smart objects, shapes, 3D ob-
jects, and video frames into raster-based objects. The box on page 52 explains the 
difference between raster and vector objects.

NEW LAYER BASED SLICE
This item adds slices for Web layouts to the currently selected layer based on its 
content; see Chapter 17 for details, starting on page 787.

GROUP LAYERS
Use this command to group active layers together. The layers will appear in their 
own folder in the Layers panel (see page 111).

UNGROUP LAYERS
This command removes layers from a group and deletes the group, though it doesn’t 
delete the layers themselves.

HIDE LAYERS
Use this command to temporarily hide layers or layer groups so you can see and 
work with objects in complex images; it’s the equivalent of turning off a layer’s vis-
ibility icon (see page 84).

ARRANGE
This item lets you change the order of layers and layer groups in the Layers panel.

COMBINE SHAPES
This menu item lets you combine and intersect objects on shape layers that you’ve 
drawn using Photoshop’s shape tools. See Chapter 13 for more on using shape lay-
ers, starting on page 580, and see page 589 for info on drawing multiple shapes 
on a single shape layer.

ALIGN LAYERS TO SELECTION
This menu item lets you align content on multiple layers to an active selection 
(marching ants).

DISTRIBUTE
This item aligns the contents of three or more layers along the object’s edges or 
center points (see page 104).
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LOCK LAYERS/LOCK ALL LAYERS IN GROUP

This command lets you lock the active layers, or lock all the layers in a group so you 
don’t accidentally edit or change them (page 110 has more on layer locks).

LINK LAYERS
Use this command to hook layers together so they move as if they were a single 
layer. You can still edit linked layers, and you can unlink them, too (see page 109).

SELECT LINKED LAYERS
Choose a linked layer and then pick this menu item to also activate all the layers 
that are linked to it.

MERGE LAYERS
This command combines the active layers or layer groups into a single layer (page 
118).

MERGE VISIBLE
Use this command to combine all your image’s visible layers into a single layer 
(page 118).

FLATTEN IMAGE
This command merges all your image’s layers into the background layer (page 120). 
Before you flatten your layers into an un-editable mess, consider creating a stamped 
copy instead, as explained on page 119.

MATTING
This option removes the extra pixels surrounding an object’s edge after you’ve 
isolated it from its original background. After you apply matting, the item’s edge 
should look cleaner and more natural against a new background (page 191). See 
Chapter 4 for more on crafting and editing selections.

Type
As you might suspect, this menu houses a slew of commands related to text that.

ADD FONTS FROM TYPEKIT
Choose this option to visit the Adobe Typekit website in your web browser, where 
you can install a multitude of free fonts that you can use in any program on your 
computer. Typekit is explained in detail starting on page 616.

PANELS
This menu item gives you access to the Character Styles and Paragraph Styles panels. 
See the box on page 651 for more info.
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ANTI-ALIAS

Use this option to control how much blurring occurs on the edges of text to make 
the letterforms smoother (or, if you like, less smooth); see page 152.

ORIENTATION
This menu lets you switch between horizontal (left-to-right, perfectly legible) and 
vertical (top-to-bottom, completely unreadable) text.

OPENTYPE
This handy menu item gives you fast access to the extra formatting goodness con-
tained in some OpenType fonts. Flip to page 614 for more info.

EXTRUDE TO 3D
This command creates a new 3D object (and 3D layer) from the currently active type 
layer. To learn more about creating 3D text, see page 887 in Chapter 21.

CREATE WORK PATH
Use this command to create an editable path out of the active type layer, which lets 
you rotate and change the shape of individual characters. See page 578 for more 
on work paths or flip to page 570 for the full scoop on paths.

CONVERT TO SHAPE
This command creates a shape layer out of an active type layer, as explained start-
ing on page 665.

RASTERIZE TYPE LAYER
This command converts a vector-based type layer into un-editable pixels.

CONVERT TO PARAGRAPH TEXT
This command converts point text (the kind that can dangle off the edge of your 
document) to paragraph text (the kind contained within a text box) and vice-versa 
(see page 621).

WARP TEXT
Use this command to summon a dialog box that lets you reshape text in a variety 
of ways. Page 633 has the scoop.

FONT PREVIEW SIZE
This handy command lets you change the size of font previews visible in the Fonts 
menus that live in the Options bar and Character panel (as explained on page 615, 
Large is a good choice).

LANGUAGE OPTIONS
This menu gives you access to the special features of East Asian and Middle Eastern 
languages.
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UPDATE ALL TEXT LAYERS

Opening a Photoshop document containing text created in an earlier version of the 
program can sometimes cause the text to reflow. This command lets you update 
all the layers in a document to the current version of the program. See the box on 
page 631 for more info.

REPLACE ALL MISSING FONTS
Use this command to replace all the missing fonts in a document with a different 
font. The box on page 631 has additional info.

PASTE LOREM IPSUM
As explained in the Tip on page 622, this command pastes a chunk of placeholder 
text into the active type layer.

LOAD DEFAULT TYPE STYLES
You can use this command to load any character or paragraph styles that you ob-
tained from someone else or downloaded from the Internet (see the box on page 651).

SAVE DEFAULT TYPE STYLES
Once you’ve formatted text to your liking, this command lets you save that style 
and include it in each new document you create. Trot on over to the box on page 
651 for more info.

Select
The items in this menu let you select layers and layer content, refine selections, use 
Quick Mask mode, and more.

ALL
This command places marching ants around the perimeter of your document and 
grabs everything on the currently active layer.

DESELECT
Use this command to get rid of the marching ants and deactivate a selection.

RESELECT
If you didn’t mean to get rid of a selection, use this command to reactivate the last 
selection you created.

INVERSE
Choose this item if you select an area and want to flip-flop the selection to select 
the part that’s not selected instead (see the box on page 167).
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sELECt
ALL LAYERS

This option activates all the visible layers in the Layers panel so you don’t have to 
activate ’em one at a time.

DESELECT LAYERS
Choose this command to deactivate the currently active layers.

FIND LAYERS
This menu item activates the row of layer-filtering options at the top of the Layers 
panel. You can learn all about this handy feature starting on page 79.

ISOLATE LAYERS
This command automatically filters your Layers panel so that you see only the cur-
rently active layers. See the “Selected” bullet point on page 81 for more info.

COLOR RANGE
This command opens a dialog box that lets you select areas in your image based 
on color (see page 165).

FOCUS AREA
New in Photoshop CC 2014, this command automatically creates a selection of the 
in-focus areas in your image. You can also use the dialog box that opens to fine-tune 
that selection, as well as send it over to the Refine Edge dialog box for even more 
tweaking. Page 179 has details.

REFINE EDGE
This command opens a dialog box that lets you fine-tune the edges of a selection, 
which is especially helpful when wispy bits like hair or fur are involved. You can learn 
all about it starting on page 181.

MODIFY
This option lets you tweak the edge of your current selection by expanding or shrink-
ing it, feathering it, grabbing just its border, or smoothing it.

GROW
This command finds and grabs pixels that match the colors around the area you’ve 
selected. (The pixels have to be adjacent to your selection—see page 165.)

SIMILAR
Like the Grow command, this option finds all the pixels in your image that match 
the selected area’s colors, but it finds similar-colored pixels anywhere in your image.

TRANSFORM SELECTION
This command lets you resize the currently selected area with a bounding box (just 
like Free Transform). You can see it in action on page 192.
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FILtER
EDIT IN QUICK MASK MODE

This option temporarily covers your image with a red overlay, or mask, letting you 
create or fine-tune a selection visually (see page 193).

LOAD SELECTION
This command lets you activate a selection you previously saved so you can use it 
again (see page 198).

SAVE SELECTION
Use this option to save a selection for future use (page 197).

NEW 3D EXTRUSION
This command lets you create a new 3D extrusion from an active selection. For more 
on 3D, trot over to Chapter 21.

Filter
This menu is packed with all kinds of effects you can apply to images. It groups 
filters by type: Artistic, Blur, Sharpen, and so on. Chapter 15 covers filters in detail.

 NOTE  Back in CS6, Adobe shortened the Filter menu by removing items that can be triggered from the 
Filter Gallery. See the box on page 674 for instructions on repopulating your Filter menu so it matches the items 
listed here.

LAST FILTER
This command applies the last filter you used—with the same settings—to the cur-
rently active layer, smart object, or layer mask.

CONVERT FOR SMART FILTERS
Use this feature to convert a regular layer, or several, into a smart object so you can 
use smart filters (see page 670).

FILTER GALLERY
Choose this option to see a preview of how your image will look if you apply various 
filters. It’s available for several filter categories, and it’s a good way to learn how 
those filters affect your image (see page 672).

ADAPTIVE WIDE ANGLE
This filter lets you easily fix distortion problems common when shooting with a 
wide-angle or fish-eye lens (see page 673).

CAMERA RAW FILTER
This command lets you open the Adobe Camera Raw plug-in as a filter inside Pho-
toshop. For the scoop, see page 677.
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FILtER
LENS CORRECTION

Not only does this filter let you add a beautifully darkened edge vignette (page 677), 
it can also correct all manner of lens distortion, as described in the box on page 679.

LIQUIFY
This filter lets you push, pull, and move pixels in all sorts of ways in order to change 
reality (page 5).

VANISHING POINT
This filter helps you maintain an image’s perspective while you paint, clone, or add 
other images to it. See page 680 for the step-by-step scoop.

3D
Use this category to generate a depth or bump map from an image for use with 
Photoshop’s 3D tools, as explained on page 895.

ARTISTIC
This category includes filters that make images look like a painting or drawing 
(page 685).

BLUR
These filters change the focus in all or part of an image (see page 685), which is 
incredibly handy when you’re softening skin (see page 460) 

BLUR GALLERY
This menu gives you access to the five additional blur filters—Field Blur, Iris Blur, 
Tilt-Shift, Path Blur, and Spin Blur—that are useful for creating shallow-depth-of-
field effects after you take the photo. You can learn all about these handy filters 
starting on page 691.

BRUSH STROKES
The filters in this category make your image look like it was painted, penciled, or 
spray-painted, among other effects; see page 702 for details.

DISTORT
These filters create geometric patterns based on your image, including ripple, twirl, 
and zigzag effects (page 704).

NOISE
This category includes filters that can help smooth areas of an image that don’t 
blend well, fix dust and scratches in photos, and remove graininess (see page 704, 
as well as the box on page 487). You can also use these filters to add grain to give 
an image more texture and depth.
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FILtER
PIXELATE

These filters convert images or selections into groups of geometric shapes and 
patterns (page 705).

RENDER
These filters let you add cloud patterns, fiber patterns, and lens flares, and adjust 
an image’s lighting (page 705).

SHARPEN
You can use filters in this category to make blurry or out-of-focus images clearer 
(see Chapter 11).

SKETCH
These filters let you add artistic effects to make images look like they were hand 
drawn with charcoal, conté crayons, graphic pens, and so on. You can even use the 
Graphic Pen filter to create fake snow, as shown on page 708.

STYLIZE
These filters accentuate the edges in an image in order to do things like turn images 
into collections of blocks or dots, convert them into pencil sketches, or add a wind-
blown look (page 709). You can use the Emboss filter in this category to sharpen a 
blurry image (see page 712).

TEXTURE
These filters make an image look like it’s on a textured surface such as tiles or stained 
glass (page 712).

VIDEO
These filters let you deinterlace (smooth) images that you’ve grabbed from videos, 
and restrict images to colors that display properly on TVs in the United States 
(NTSC-safe colors). For more on working with video in Photoshop, see Chapter 20.

OTHER
This catch-all category includes options that let you build your own custom filters 
and adjust a layer mask’s size, among other things. Page 714 has more info.

DIGIMARC
These filters let you add a watermark and copyright info to images (see page 716).

BROWSE FILTERS ONLINE
This option fires up your web browser and takes you to the Adobe Add-Ons website 
so you can browse and download even more filters and other goodies.
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3D 3D
The items in this menu pertain to creating and working with 3D objects in Photoshop, 
which is covered in Chapter 21.

NEW 3D LAYER FROM FILE
Creates a new 3D layer in the currently open document from another document that 
you navigate to on your hard drive via a dialog box.

MERGE 3D LAYERS
This command combines the currently active 3D layers into a single layer and de-
letes the original layers. This maneuver lets you move and manipulate them as if the 
contents were one piece, though you can still edit the individual 3D objects even 
though they reside on a single layer. 

EXPORT 3D LAYER
Choose this command to export the contents of the currently active layer to a variety 
of formats for use with other programs.

SHARE 3D LAYER ON SKETCHFAB
Prepares and uploads your 3D object to the online 3D printing service Sketchfab.com.

GET MORE CONTENT
Transports you to the 3D section of Photoshop.com, where you can download models, 
materials, meshes, and so on for use in your projects.

NEW 3D EXTRUSION FROM SELECTED LAYER
Creates a new 3D layer from the contents of the currently active layer.

NEW 3D EXTRUSION FROM SELECTED PATH
As you might suspect, this command creates a new 3D layer from the currently ac-
tive path (see page 570 for more on paths).

NEW 3D EXTRUSION FROM CURRENT SELECTION
This command creates a new 3D layer from the currently selected objected (denoted 
by marching ants). See Chapter 4 for more on creating selections.

NEW MESH FROM LAYER
Creates a wire-frame mesh from the currently active layer comprised of thousands of 
polygons, which lets you manipulate the layer’s contents in 3D space (see page 879).

GROUP OBJECTS
Groups all the currently active objects so you can manipulate them as one.
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3D
GROUP ALL OBJECTS IN SCENE

Groups all the objects in your scene so you can scale, rotate, or move them as if 
they were one piece.

MOVE OBJECT TO GROUND PLANE
This command snaps the selected object to the ground plane (page 881).

PACK OBJECTS ON GROUND PLANE
Use this command to print multiple instances of the same object onto the same 
build plate (printing surface). To do so, activate the object(s) in the 3D panel, and 
then choose this command.

NEW TILED PAINTING FROM LAYER
Choose this command to create a seamless tiled pattern from the currently active 
layer.

GENERATE UVS
Choose this command to prompt Photoshop to regenerate any edges or facets of 
your 3D object, which is helpful when you’re trying to paint across an object that 
has seams (like a soccer ball, say).

PAINT FALLOFF
You can use this option to control the amount of paint Photoshop applies to a surface 
as it curves away from you.

PAINT SYSTEM
Let’s you switch between Photoshop’s Texture and Projection systems for applying 
paint to a 3D object.

PAINT ON TARGET TEXTURE
Lets you choose the specific texture onto which you want to apply paint (you have 
eight to pick from).

SELECT PAINTABLE AREAS
This command automatically selects areas of the 3D mesh onto which you can suc-
cessfully apply paint.

CREATE PAINTING OVERLAY
Lets you control how texture is applied or mapped onto to your 3D object.

SPLIT EXTRUSION
Splits a 3D object into individual meshes that you can then manipulate individually 
(similar to how a jigsaw puzzle is split into separate pieces).
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3D
APPLY CROSS SECTION TO SCENE

Use this command to slice off parts of a 3D model before printing it. To do so, click 
Scene in the 3D panel, and then in the Properties panel, turn on the Cross Section 
checkbox. In the resulting fields, enter the settings you want to use for the cross 
section, and then choose this menu item to make it so.

UNIFY SCENE FOR 3D PRINTING
Prepares your 3D scene for printing by unifying all the objects so they’re watertight 
(solid).

ADD CONSTRAINT(S) FROM
Choose this command to create a constraint—a hole or shape you want to extrude 
from the 3D object—from a selection (marching ants) or the currently active path.

SHOW/HIDE POLYGONS
Lets you see the thousands of individual polygons that comprise the wire-frame mesh.

MAKE WORK PATH FROM 3D LAYER
This command creates a path from the currently active 3D layer. For more on paths, 
see Chapter 14.

RENDER
Creates a full-resolution, high-quality version of the 3D scene you’ve created (see 
page 903).

SKETCH WITH CURRENT BRUSH
This option lets you experiment with custom brush settings to create a texture file 
that you can apply to the 3D object’s mesh.

3D PRINT SETTINGS
Opens the Properties panel and displays crucial settings for 3D printing, such as 
where you want to print the object (on your own 3D printer or via a 3D printing 
service), the level of detail, and more. See page 906 for a full listing and explana-
tion of these settings. 

3D PRINT
This command unifies the scene, making it watertight, and (eventually) opens a 
dialog box containing a print preview of your 3D object (see page 905).

CANCEL 3D PRINT
As you might suspect, this command cancels the 3D print you’ve triggered.

3D PRINT UTILITIES
If you have a 3D printer connected to your computer, this command opens its utili-
ties dialog box (for calibration and so on).
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VIEWView
This menu gives you all sorts of different ways of looking at images, from zooming 
in or out to adding guides and rulers. (See Chapter 2 for more document-viewing 
options than you can shake a stick at.)

PROOF SETUP
Use the items in this submenu to create a proof, a sample version of your image that 
simulates what the finished piece will look like. You can simulate how your image’s 
colors will look on a Mac or PC monitor or in another color mode—and even how 
a color-blind person would see them. This preview process, called soft proofing, is 
discussed in more detail on page 757.

Proof Colors

This option turns soft proofing on or off (see page 755).

GAMUT WARNING
Turn this feature on to make Photoshop highlight areas of your image that fall outside 
of the safe color range, or gamut, for the color mode you’re working in (see Figure 
16-19 on page 758).

PIXEL ASPECT RATIO
This item lets you change the shape of your image’s pixels for video projects.

PIXEL ASPECT RATIO CORRECTION
Turn this feature on when you’re working with a video format in which the pixels aren’t 
square, so your images don’t look stretched when viewed on your computer monitor.

32-BIT PREVIEW OPTIONS
Because the dynamic range in 32-bit HDR images is greater than the color range 
most monitors can display, this option compensates for washed-out highlights and 
overly dark shadows. To learn more about HDR photography, see page 421.

ZOOM IN
This command works like a magnifying glass, increasing your image’s magnification 
level (see page 56).

ZOOM OUT
This command decreases your image’s magnification level.

FIT ON SCREEN
Choose this command to have Photoshop change the zoom level of your docu-
ment so you can see the whole image. It’s especially handy when you’re using Free 
Transform—Photoshop zooms out of your document just enough for you to see all 
four corners of the bounding box so you can grab ’em.
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VIEW
100%

This option adjusts your view of the current image and the window it’s in so that 
you’re viewing it at 100% zoom level on your screen (otherwise known as actual size).

200%
This command accommodates those users with a super high-resolution Apple Retina 
or Windows HiDPI display and lets you view the current document at 200% zoom, 
which makes Web graphics appear at about the size visitors are likely to see ’em in 
a web browser.

PRINT SIZE
This item changes the size of your image to show how big or small it will be when 
you print it. See Chapters 6 and 16 for more on resizing images for print.

SCREEN MODE
This submenu lets you choose how you want to view images. Page 6 explains your 
options.

EXTRAS
With this option turned on, you can add alignment helpers like guides and grids to 
your images. (If you use one of these features, Photoshop automatically turns on 
Extras for you.) Page 67 has the details.

SHOW
This submenu lists the extra items you can display and use while you’re editing im-
ages: guides, layer edges, notes, and more.

RULERS
This command shows or hides the horizontal and vertical rulers that run along the 
document window’s left and top edges (see page 67).

SNAP
Choose this item to turn snapping on or off. (As page 68 explains, snapping lets you 
align objects with guides and other items.)

SNAP TO
Here’s where you choose which items objects snap to: guides, grids, layers, slices, 
document bounds, or all of those things.

LOCK GUIDES
This command prevents you from accidentally moving guides you’ve added to an 
image (page 68). If you’ve already locked your guides, choose this command again 
to unlock them.

CLEAR GUIDES
Choose this option to get rid of all the guides you’ve added to the current document.
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WInDoW
NEW GUIDE

Lets you add vertical and horizontal guides to an image.

LOCK SLICES
Choose this item to keep your image slices (page 787) where they are.

CLEAR SLICES
Removes all the slices from the current image.

Window
Use this menu to change what you see in Photoshop. It lets you arrange open docu-
ments, view or hide panels, and so on.

ARRANGE
This submenu has commands for organizing your open document windows. From 
here, you can do things like open and close panels, set the same magnification level 
across all your documents, minimize windows, and bring all your documents in front 
of other windows.

WORKSPACE
The items in this submenu rearrange Photoshop’s panels, menus, and tools to make 
it easier to perform certain tasks like painting or working with text. Page 12 explains 
workspaces and why you may want to use ’em.

EXTENSIONS
Look here for a list of the HTML-based Photoshop extensions installed on your ma-
chine, like the collaborative, online color-scheme generator called Kuler. As explained 
in the Tip on page 521, this menu used to contain Flash-based panels, but Adobe 
removed them in Photoshop CC 2014.

3D
Choose this item to make Photoshop open the 3D panel (see Chapter 21).

ACTIONS
Choose this option to open the Actions panel, where you can see a list of the actions 
that came with Photoshop, plus any actions that you’ve created. You can also use 
this panel to manage actions, as explained in Chapter 18.

ADJUSTMENTS
This panel lets you add adjustment layers that you can use to nondestructively alter 
an image’s color and lighting.
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WInDoW
BRUSH

This panel lets you activate and customize Photoshop’s built-in brushes, as well as 
brushes you’ve created or loaded, to an incredible level. Chapter 12 teaches you 
more than you ever wanted to know about the Brush panel and describes each 
customization option beginning on page 548.

BRUSH PRESETS
This panel shows you currently loaded brushes, the last 30 brushes you used, dis-
plays a cross-section of the currently active brush tip, and more. You can also use 
it to load additional brushes and create new presets. 

CHANNELS
This panel shows the different color channels contained in your document. Chapter 
5 has the skinny on channels.

CHARACTER
The Character panel is where you can find all sorts of settings for working with text. 
See Chapter 14 to learn all about it.

CHARACTER STYLES
This menu item lets you save and apply character text formatting options. See the 
box on page 651 for more info.

CLONE SOURCE
This panel groups together settings for using the Clone tools (see pages 319 and 449).

COLOR
Use this panel to view and change the foreground and background color chips at 
the bottom of your Tools panel. In Photoshop CC 2014, it functions as a Color Picker 
that’s always open (page 527).

HISTOGRAM
This panel includes a graph (called a histogram) that shows you information about 
the pixels in your image. Turn to page 398 to learn how to decipher histograms.

HISTORY
The History panel displays a timeline of the edits you’ve made to the current docu-
ment. It also shows what the image looked like last time you saved it and lets you 
restore the image to any previous state. See page 17 for details.

INFO
This panel includes info about where your cursor is, the color of the pixels your cur-
sor is pointing at, and the size of your current selection (if you have one). You can 
see it in action in Figure 9-18 on page 409. 
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WInDoW
LAYER COMPS

This panel lets you view and organize groups of layers you can use to show different 
versions of your image in a single document (see page 113).

LAYERS
You can add, delete, and organize your document’s layers from this panel. Chapter 
3 is all about layers.

MEASUREMENT LOG
This is where you can see data collected by the Count tool (see online Appendix C).

NAVIGATOR
This panel lets you change how much you’re zoomed in on an image and which part 
of the image you’re viewing (see page 60).

NOTES
You can view, edit, and delete notes from this panel (see online Appendix C).

PARAGRAPH
This panel lets you control the paragraph-wide settings for text in your documents 
(see page 649).

PARAGRAPH STYLES
This panel lets you create and apply paragraph-specific formatting options. See the 
box on page 651 for more info.

PATHS
You can keep track of all the paths in your image with this panel. You can also use 
it to change the stacking order of paths, as well as add and delete them. See page 
570 in Chapter 13 for more on paths.

PROPERTIES
This panel lets you tweak the settings for adjustment layers and layer masks (see 
page 127).

STYLES
You can use this panel to apply Photoshop’s built-in styles to your images (page 
144), as well as create and save your own custom styles.

SWATCHES
Here’s where you can view and pick colors from libraries of color chips (see page 
525). Photoshop includes a long list of popular libraries including several Pantone, 
Toyo, and Trumatch color groups.
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hELP
TIMELINE

This command opens the Timeline panel (named Animation in previous versions of 
the program) that you can use to create a frame-based animation (see page 780) 
or a video project complete with multiple clips, transitions, audio, and more (see 
page 849).

TOOL PRESETS
If you regularly use the same settings for a particular tool, use this panel to save 
them as a preset so you can use them again later. Page 32 has more about working 
with presets.

APPLICATION FRAME (MAC ONLY)
Mac users can choose this item to turn Photoshop’s Application Frame on or off 
(page 3).

OPTIONS
This menu item shows or hides the Options bar, which lets you customize how Pho-
toshop’s tools behave (page 4).

TOOLS
Choose this option to show or hide the Tools panel (page 13). You’ll work with this 
panel all the time, so you’ll want to leave it visible.

OPEN DOCUMENTS
The bottom portion of the Window menu doesn’t actually have a label, but it’s where 
Photoshop lists all the documents you currently have open (in alphabetical order).

Help
If you don’t know how to do something in Photoshop, you may find the answer in 
this menu. It includes a link to Adobe’s online help system, several tutorials, and op-
tions for activating and deactivating your copy of Photoshop (see online Appendix 
A). You need an active Internet connection to use almost every item in this menu.

 NOTE  In the Windows version of Photoshop, this menu also includes the About Photoshop and About Plug-In 
items described earlier in this appendix.

SEARCH (MAC ONLY)
Can’t find a menu item? Mac users can use this field to type the name of a command 
and have Photoshop automatically highlight that command wherever it lives within 
the program’s menu system.
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hELP
WHAT’S NEW

Transports you to an Adobe web page listing most of the new features in the cur-
rent version of the program. As you might guess, an Internet connection is required.

PHOTOSHOP ONLINE HELP
Here’s where you can access Photoshop’s online help system (see online Appendix 
B), but you need an active Internet connection. (That being said, you can download 
the help file to your computer as a PDF! Online Appendix B explains how.)

PHOTOSHOP SUPPORT CENTER
This command opens the Learn & Support section of the Photoshop section of 
Adobe’s website (of which the online help area mentioned above is part). 

LEGAL NOTICES
Yes, Adobe dedicated a menu item to Photoshop’s laundry list of patents and other 
legal info. It’s fun reading if you’re into that kind of thing.

MANAGE EXTENSIONS
Opens the Adobe Extension Manager app, which lets you manage any HTML-based 
extensions you’ve installed.

BROWSE ADOBE ADD-ONS
This command takes you to the Adobe Add-Ons website, where you can download 
all manner of presets, filters, and so on, uploaded by other members of the Adobe 
community. Some are free and some are fee-based.

SYSTEM INFO
When you choose this item, Photoshop generates a report that lists facts like which 
OpenGL components your video card supports (see the box on page 66), which 
version of Photoshop you’re using, and which plug-ins you’ve installed.

MANAGE MY ACCOUNT
Use this option to change your subscription plan, payment method, password, as 
well as complete and/or update the information associated with your Adobe ID. (To 
learn more about installing Photoshop, see online Appendix A).

SIGN OUT
This menu item lets you sign out of your current Adobe ID in order to sign in with a 
different one, which is helpful when you’ve synced settings with the Adobe Creative 
Cloud and you need to access ’em on another machine. See the box on page xxvii 
for more on the Creative Cloud.

UPDATES
Choose this option to make Photoshop check for updates (see online Appendix A).
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hELP
PHOTOSHOP ONLINE

This item opens your web browser to Adobe’s main Photoshop web page.

PHOTOSHOP RESOURCES ONLINE
This command opens your web browser and loads Adobe’s downloadable-content 
page where you can find optional plug-ins and a list of plug-ins that are no longer 
supported (such as Variations, Picture Package, and so on).




